## Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Textual cross-references to other documents.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><strong>&lt;Example&gt;</strong></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard, for example, F2 or ENTER.</td>
</tr>
</tbody>
</table>
## Document History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2015-07-06</td>
<td>Version 1</td>
</tr>
<tr>
<td>2.0</td>
<td>2016-01-15</td>
<td>General Update</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 6 (Transportation)</td>
</tr>
</tbody>
</table>
# Table of Contents

1 Purpose 6

2 Technical System Landscape 7
   2.1 Transactional Apps Landscape 7
   2.2 Fact Sheets Landscape 8
   2.3 Analytical Apps Landscape 8

3 Generic Configuration 10
   3.1 Creating Fiori Users 11
   3.2 Connecting SAP NetWeaver Gateway to SAP Business Suite 11
      3.2.1 Gateway System: Assign Role Template for Administrators 11
      3.2.2 Automated Configuration with Task Lists 12
      3.2.2.1 Task List SAP Gateway - Basic Configuration 12
      3.2.2.2 Task List Create Trusted Connection from SAP System to SAP Gateway 14
      3.2.2.3 Task List SAP Gateway - Add Backend System 15
      3.2.2.4 Task List SAP Basis SSL Check 16
      3.2.3 Manual Activity (Optional) 17
      3.2.3.1 Gateway System: Activating SAP NetWeaver Gateway 18
      3.2.3.2 Gateway System: Creating Trusted RFC in NetWeaver Gateway to SAP Business Suite 18
      3.2.3.3 Defining Trust Between SAP Business Suite and SAP NetWeaver Gateway 19
      3.2.3.4 Gateway System: Creating System Alias 20
   3.3 Configuring SAP Web Dispatcher 21
   3.4 Setting up the Fiori Launchpad and Launchpad Designer 25
      3.4.1 Automated Configuration with Task Lists 25
      3.4.1.1 Task List SAP Fiori Launchpad Initial Setup 25
      3.4.2 Manual Activity (Optional) 26
      3.4.2.1 Gateway System: Activating Launchpad OData Services 26
      3.4.2.2 Gateway System: Configuring ICF Nodes 27
      3.4.2.3 Gateway System: Activating the Cache Buster 28
      3.4.3 Gateway System: Configuring Login Screen for Launchpad and Launchpad Designer 29
      3.4.4 Gateway System: Adapting the Logout Page in the SAP Fiori Launchpad (Optional) 30
      3.4.5 Gateway System: Configuring Authorization Roles 32
      3.4.6 Gateway System: Assign Generic Roles for Administrators and End Users 34
      3.4.7 Testing the Fiori Launchpad 34
   3.5 Generic Configuring for Fact Sheet 35
      3.5.1 Backend System: Assign Roles for Embedded Search Administration 35
      3.5.2 Backend System: Activating Embedded Search Business Functions 36
      3.5.3 Automated Configuration with Task Lists 36
      3.5.3.1 Task List Initial Setup of Embedded Search (Client 000) 36
      3.5.3.2 Task List Initial Setup of Embedded Search (Working Client) 37
      3.5.4 Manual Activity (Optional) 39
      3.5.4.1 Backend System: Prepare Model Data 39
      3.5.4.2 Backend System: Check Primary Database Connection to SAP HANA 39
      3.5.4.3 Backend System: Creating a Connection Between Embedded Search and SAP HANA 40
      3.5.4.4 Backend System: Activating Embedded Search UI Services 41
      3.5.4.5 Backend System: Create Search Connectors 41
      3.5.4.6 Backend System: Schedule Indexing 43
      3.5.5 Backend System: Check UI Area Key for Fact Sheet 44
   3.6 Generic Configuration for Analytical App 44
      3.6.1 HANA DB: Assign Roles for Accessing SAP Smart Business Modeler 44
      3.6.2 Gateway System: Assign Role for Accessing SAP Smart Business Modeler 45
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.6.3 HANA DB: Check Time Dimension</td>
<td>46</td>
</tr>
<tr>
<td>4 Transportation</td>
<td>48</td>
</tr>
<tr>
<td>5 Appendix</td>
<td>50</td>
</tr>
<tr>
<td>5.1 Displaying Task List Documentation</td>
<td>50</td>
</tr>
<tr>
<td>5.2 Displaying Log Information for Task List Runs</td>
<td>50</td>
</tr>
</tbody>
</table>
1 Purpose

1. Describe the general configuration steps required to manually set up the configuration within the system landscape; alternatively, perform ABAP system configuration tasks in an automated way by using predefined task lists for some configuration steps.

2. Provide the general configuration steps in each SAP Fiori scenario. There are three scenarios for SAP Fiori: Transactional apps, Analytical apps and Fact sheets. Each scenario has its specific systems or software to be installed. By reading through this document, it is able to setup the customer specific SAP Fiori landscape based on the required system environment.
2 Technical System Landscape

SAP Fiori has three app types, each distinguished by their focus and infrastructure requirements:
- Transactional apps
- Fact sheets
- Analytical apps (smart business apps and Non-smart business apps)

When installing SAP Fiori apps, we recommend separating the front-end components with the UI layer from the back-end components that contain the business logic and the back-end data. For more detail information regarding the installation, please refer to Configuration Guide - Getting started with implementing the SAP Fiori Apps Rapid-Deployment Solution.

2.1.1 Transactional Apps Landscape

These are mainly apps that run best on SAP HANA but can also be ported to other databases with reasonable efforts and acceptable performance. These scenarios are typically transactional and represent views on and interaction with existing business processes and solutions.

These apps are used for performing transactional tasks, such as creating a leave request for an employee. They represent simplified views and interaction with existing business processes and solutions. They run best on an SAP HANA database.

The figure below shows the System Landscape for Transactional Apps.
2.1.2 Fact Sheets Landscape

Contextual information about central objects used in the business operations are displayed in these apps. Fact sheets are designed to be intuitive and harmonized. From a fact sheet area (tile), it is possible to drill down into its details. It’s easy to navigate from one fact sheet to its related fact sheets. For example, navigate from a document to the related business partner or to the master data. From fact sheets, it is also possible to access related transactions in operational systems. Access the back-end system to display document details or to edit the document from a document fact sheet is also possible.

Fact sheets run only on an SAP HANA database and require an ABAP stack. The figure below shows the System Landscape for Fact Sheets.

2.1.3 Analytical Apps Landscape

It is possible to get a role-based insight into real-time operations of the business by collecting and displaying key figures directly in the browser through the SAP Analytical apps. To do this, the SAP Analytical apps combine the data and analytical power of SAP HANA with the integration and interface components of SAP Business Suite. With SAP Analytical, the customer’s company is able to closely monitor its most important KPIs in real time and react immediately on changes in market conditions or operations.
The figure below shows the System Landscape for Analytical Apps:
3 Generic Configuration

This section includes the generic configuration steps that have to perform for the following:

- Creating Fiori Users
- Connecting SAP NetWeaver Gateway to SAP Business Suite
- Configuring SAP Web Dispatcher (Fact sheets and Analytical apps only). Configuring Embedded Search in the Back-End Suite On HANA (Fact sheets only)
- Setting up the Fiori Launchpad and Launchpad Designer
- Generic Configuration for Fact Sheet
- Generic Configuration for Analytical App

Purpose

The steps covered in chapter Generic Configuration describe both automated way by using predefined task lists and manual steps. For some of the predefined task lists, you can alternatively perform manual steps. For an easier and faster configuration via an automated configuration, using task list is always preferred. Carefully check that you have covered all configuration steps at the end since as of now not all the manual steps are covered in these automation steps.

⚠️ Caution

Be aware that some steps within the task lists are not required for the configuration/activation of Fiori and hence these steps do not show up in the manual step description, that is: a one to one mapping of manual and automated configuration step is in some cases is not possible.

Prerequisites

- The predefined task lists are available for every SAP NetWeaver 7.4 SP6 ABAP system (delivered via Software Component SAP_BASIS). Using SP08, additional task lists were delivered – check SAP Note 2017302.

⚠️ Note

The customer must check if SAP NetWeaver 7.4 with the minimum SP level, is in use. There are no downports for SAP NetWeaver 7.31 available.

- You have implement SAP Note 2017302 to get the predefined task lists for Fiori frontend configuration.
3.1 Creating Fiori Users

Use

An admin user and an end user are created in ABAP Front-end server, Suite on HANA server, and HANA server to facilitate further role-based configuration tasks and verification processes. Alternatively, if such users already exist, only the role assignment is needed.

Procedure

1. Login into the ABAP front-end server.
2. Access the activity using the following navigation options:
   
   **Transaction Code**: SU01

3. Create administrator user FIORI_ADM and end user FIORI_USER.
4. Login into the Suite on HANA server.
5. Access the activity using the following navigation options:

   **Transaction Code**: SU01

6. Create administrator user FIORI_ADM and end user FIORI_USER.
7. Go to SAP HANA studio, go to the SAP HANA Systems view, and choose Security → Users.
8. Create the database users FIORI_ADM and FIORI_USER.

   **Note**

   User FIORI_ADM is to be used by administrators or consultants, who perform the configuration. User FIORI_USER is to be used by end user or testers, who perform verification.

3.2 Connecting SAP NetWeaver Gateway to SAP Business Suite

3.2.1 Gateway System: Assign Role Template for Administrators

Use

To create roles to provide all users with access to create Trusted RFC in SAP NetWeaver Gateway, proceed as follows.
Procedure

1. In the SAP Gateway system, access the activity using one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>PFCG</td>
<td>Tools → Administration → User Maintenance → Role Administration → Roles</td>
</tr>
</tbody>
</table>

2. Enter the name of the role, for example, Z_RT_ADMIN.
3. Choose Single Role to create the user role.
4. Open the Authorizations tab, in the Save the role dialog box, choose Yes.
5. Choose Change Authorization Data to specify a template for the role.
6. In the Choose Template dialog box, Select the Template /IWFND/RT_ADMIN and choose Adopt reference.
7. Choose Generate (Shift + F5) and press Enter.
8. Choose Back and click on Generate (F6).
9. Open the User tab, Insert the administrator user ID/name in the User Assignments area, for example, FIORI_ADM.
10. Choose Save (Ctrl+S).

3.2.2 Automated Configuration with Task Lists

3.2.2.1 Task List SAP Gateway - Basic Configuration

Use

You use task list SAP_GATEWAY_BASIC_CONFIG to perform basic configuration steps for SAP Gateway.

Procedure

1. Log on to your SAP ABAP system.
2. Call the following transaction:

| Transaction Code | STC01 |

4. Choose Generate Task List Run (F8). The Maintain Task List Run screen is displayed.
5. Before starting the task list run, make sure you have selected the Execute checkbox for the respective task list and set the parameters accordingly:
   - Activate HTTP Services for NW Gateway (SICF)
   - Gateway Activation (/IWFND/IWF_ACTIVATE)
   - Metadata Cache Activation (/IWFND/MED_ACTIVATE)
   - Report /IWFND/R_COV_VIRUS_PROFILE - SAP Gateway Virus Scan Profile Configuration [Parameter maintenance]
   - Configuration Parallelization of Batch Queries (/IWBEP/BATCH_CONFIG) [Parameter maintenance]
   - Gateway Metadata Cache Cleanup (/IWFND/CACHE_CLEANUP)
   - OData Metadata Cache Cleanup (/IWBEP/CACHE_CLEANUP)

6. Choose Start/Resume Task List Run in Dialog (or in Background). Once the task list run has been finished successfully, green lights appear in the Status column.

   Note

For the virus scan profile and parallelization of batch queries configuration, choose the icon in the Parameters column and set the parameters accordingly.

The task 'Metadata Cache Activation (/IWFND/MED_ACTIVATE)' is used to activate or deactivate cache for the metadata. This is equivalent to the execution of transaction /IWFND/MED_ACTIVATE. The standard setup depends on the system type:
- In a productive system the cache is activated
- In a development system the cache is deactivated.

SAP recommends that leave the cache in a deactivated state in all development systems.

In case you need a detailed description of the single steps, select the task documentation icon in the help column.

For the virus scan profile configuration, you can check further details following IMG:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP Reference IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRO</td>
<td>SAP NetWeaver → Gateway → Odata Channel → Administration → General Settings → Define Virus Scan Profiles</td>
</tr>
</tbody>
</table>

Result

You have successfully carried out the task list run SAP_GATEWAY_BASIC_CONFIG.

To check the task list run, call the respective transaction named in brackets above. For example, in transaction SICF, you can check the activation of the following HTTP services for NW Gateway:
3.2.2.2 Task List Create Trusted Connection from SAP System to SAP Gateway

Use

You use task list SAP_SAP2GATEWAY_TRUSTED_CONFIG to create a trusted connection from an SAP system to SAP Gateway. In case of Embedded Scenario of Gateway deployment, skip this step.

⚠️ Caution

This task list needs to be executed in the respective backend system and NOT as all the other task lists in the SAP Gateway system.

Procedure

1. Log on to your SAP ABAP system.
2. Call the following transaction:

   | Transaction Code | STC01 |

4. Choose Generate Task List Run (F8). The Maintain Task List Run screen is displayed.

5. Before starting the task list run, make sure you have selected the Execute checkbox for the respective task list and set the parameters accordingly:

   - Create/Select ABAP RFC Destination to SAP System (SM59) [Parameter maintenance]
Note

Before carrying out this task list run, you must fill parameters. In the Parameters column, choose and make the respective entries on the Edit Variants screen.

- Add SAP System as trusted system (SMT1)
- Set profile para RZ10 login/accept_sso2_ticket=1
- Set profile para RZ10 login/create_sso2_ticket =1
- Configure Logon Ticket for SSO (STRUSTSSO2)

6. Choose Start/Resume Task List Run in Dialog (or in Background). Once the task list run has been finished successfully, green lights appear in the Status column.

Result

You have successfully carried out the task list run SAP_SAP2GATEWAY_TRUSTED_CONFIG and created a trusted RFC Connection from a SAP Backend System to your SAP Front End Server.

3.2.2.3 Task List SAP Gateway - Add Backend System

Use

You use task list SAP_GATEWAY_ADD_SYSTEM to connect an SAP system (backend) to an SAP Gateway system (frontend).

Procedure

1. Log on to your SAP ABAP system.
2. Call the following transaction:

   | Transaction Code | STC01 |

4. Choose Generate Task List Run (F8). The Maintain Task List Run screen is displayed.
5. Before starting the task list run, make sure you have selected the Execute checkbox for the respective task list and set the parameters accordingly:
   - Check authorization for current user in SAP System [Manual step]
   - Create / Select Customizing Request (SE09) [Parameter maintenance]
   - Create / Select trusted ABAP RFC Destination to SAP System (SM59) [Parameter maintenance]
   - Set Profile Parameter: login/accept_sso2_ticket=1 (RZ10)
   - Set Profile Parameter: login/create_sso2_ticket=2 (RZ10)
   - Configure Logon Ticket for Single Sign-On (STRUSTSSOL)
   - Create System Alias for SAP System [Parameter maintenance]

6. As the icon in the Status column implies, the first task displayed in this list has to be carried out manually: Check authorization for current user in SAP System.

7. Once the manual task has been finished, choose the icon in the Status column.

8. Confirm the popup message. A green light indicating Executed successfully is displayed in the Status column.

9. Choose Start/Resume Task List Run in Dialog (or in Background). Once the task list run has been finished successfully, green lights appear in the Status column.

Result

You have successfully carried out the task list run SAP_GATEWAY_ADD_SYSTEM.

3.2.2.4 Task List SAP Basis SSL Check

Use

You use task list SAP_BASIS_SSL_CHECK to perform a basic SSL check.

Procedure

1. Log on to your SAP ABAP system.
2. Call the following transaction:

4. Choose Generate Task List Run (F8). The Maintain Task List Run screen is displayed.

5. Before starting the task list run, make sure you have selected the Execute checkbox for the respective task list and set the parameters accordingly:
   o Check SAP Cryptographic Library [Parameter maintenance]
   o Check ICM HTTPS Configuration [Parameter maintenance]
   o Check SSL Profile Parameter [Parameter maintenance]
   o Check SSL Server and SSL Client Standard PSE [Parameter maintenance]

6. Choose Start/Resume Task List Run in Dialog (or in Background). Once the task list run has been finished successfully, green lights appear in the Status column.

Result

You have successfully carried out the task list run SAP_BASIS_SSL_CHECK.
In case the verification results fail, check ‘Basic Network and Security Configuration (EE1)’ configuration guide.

3.2.3 Manual Activity (Optional)

Note

All these manual configuration steps has been covered by Automated Configuration with Task Lists. If all the task lists have been carried out successfully, all these steps mentioned in the chapter can be skipped.
### 3.2.3.1 Gateway System: Activating SAP NetWeaver Gateway

**Procedure**

1. In the ABAP Front-End Server, access the activity using the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP Reference IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRO</td>
<td>SAP NetWeaver → SAP Gateway → OData Channel → Configuration → Activate or Deactivate SAP NetWeaver Gateway</td>
</tr>
</tbody>
</table>

2. Choose *Activate*. A message is displayed to inform the current status.

   **Note**
   Alternatively, you can also execute transaction /IWFND/IWF_ACTIVATE.

### 3.2.3.2 Gateway System: Creating Trusted RFC in NetWeaver Gateway to SAP Business Suite

The trust relationship is defined between the SAP Business Suite system and the SAP NetWeaver Gateway system by configuring the SAP NetWeaver Gateway system to be the trusting system, the SAP Business Suite system (backend system) to be the trusted system. Below are the steps need to be finished in the gateway system.

**Note**
This is a RFC destination used to establish the trust which will be used during runtime.

**Procedure**

1. In gateway system, access the activity using one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SM59</td>
<td>Tools → Administration → Administration → Network → RFC Destinations</td>
</tr>
</tbody>
</table>

Choose *Create*.

2. In the *RFC Destination* field, enter the RFC destination name in the following format: `<system_id>`<CLNT><Client>.

3. In the *Connection Type* field, enter 3.

4. In the *Description 1* field, enter an explanatory text, for example, *RFC Destination to SAP Business Suit*.

5. Save the settings.

6. On tab *Technical Settings*, enter the parameters according to the table below:
### Field Name | Entry
---|---
Load Balancing Status | No
Target Host | `<Server name of Business suit system>`
  |   For example, vhcalerpci.wdf.sap.corp
System Number | `<Business Suit System number>`
  |   For example, 00

7. On tab Logon & Security, enter the following parameters.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>EN</td>
</tr>
</tbody>
</table>
| Client | `<Client of Business Suit system>`
  |   For example, 180
| User | Check current user |

8. For Trust Relationship, activate Yes.

9. Save the settings.

### 3.2.3.3 Defining Trust Between SAP Business Suite and SAP NetWeaver Gateway

The trust relationship is defined between your SAP Business Suite system and the SAP NetWeaver Gateway system by configuring the SAP Business Suite system (backend system) to be the trusting system, and the SAP NetWeaver Gateway host to be the trusted system. Below are the steps that need to be finished in the business suite system.

1. **Note**
   
   This is a RFC destination used to establish the trust which will be used during runtime.

#### Procedure

1. In your Business Suite system, access the activity using one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SM59</td>
<td>Tools → Administration → Administration → Network → RFC Destinations</td>
</tr>
</tbody>
</table>

   Choose Create (F8).

2. In the RFC Destination field, enter the RFC destination name in the following format: `<system id >CLNT<Client>`.

3. In the Connection Type field, enter 3.

4. In the Description 1 field, enter an explanatory text, for example, RFC Destination to SAP NetWeaver Gateway.
5. Save the settings.
6. On the Technical Settings tab, enter the parameters according to the table below:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Balancing Status</td>
<td>No</td>
</tr>
<tr>
<td>Target Host</td>
<td>&lt;Server name of Gateway System&gt;</td>
</tr>
<tr>
<td></td>
<td>For example, vhcalabaci.wdf.sap.corp</td>
</tr>
<tr>
<td>System Number</td>
<td>&lt;Gateway System number&gt;</td>
</tr>
<tr>
<td></td>
<td>For example, 00</td>
</tr>
</tbody>
</table>

7. On tab Logon & Security, enter the following parameters.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>EN</td>
</tr>
<tr>
<td>Client</td>
<td>&lt;Client of Gateway system&gt;</td>
</tr>
<tr>
<td></td>
<td>For example, 080</td>
</tr>
<tr>
<td>User</td>
<td>Check current user</td>
</tr>
</tbody>
</table>

8. Save the settings.
9. In transaction SMT1, choose Create.
10. Proceed with the steps outlined in the wizard. In the RFC Destination field, enter the RFC destination which created to represent the gateway system. A RFC logon to the SAP NetWeaver Gateway system takes place and the necessary information is exchanged between the systems.
11. Log on to the SAP NetWeaver Gateway host using the administrator user and password. The trusted entry for the SAP NetWeaver Gateway host displays.
12. Save the settings.

⚠️ Caution

End users must have authorization object S_RFCACL assigned to them before they can use a trusted connection. For more information, see RFC Trusted/Trusting Systems.

### 3.2.3.4 Gateway System: Creating System Alias

**Procedure**

1. In the ABAP Front-End Server, access the activity using one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP Reference IMG menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRO</td>
<td>SAP NetWeaver → Gateway → OData Channel → Configuration → Connection Settings → SAP NetWeaver Gateway to SAP System → Manage SAP System Aliases</td>
</tr>
</tbody>
</table>

2. Choose New Entries.
3. Enter the following parameters.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System Alias</td>
<td><code>&lt;your RFC destination name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>For example, ERPCLNT180</td>
</tr>
<tr>
<td>Description</td>
<td>Description of your system</td>
</tr>
<tr>
<td>RFC Destination</td>
<td><code>&lt;your RFC destination name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>For example, ERPCLNT180</td>
</tr>
<tr>
<td>Software Version</td>
<td>DEFAULT</td>
</tr>
</tbody>
</table>

4. Choose **Save**.

**Note**

The system alias which represents the NetWeaver Gateway system itself, **Local**, should have been maintained by default. If not, please maintain it with the following parameters.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System Alias</td>
<td><strong>Local</strong></td>
</tr>
<tr>
<td>Description</td>
<td><strong>Local System Alias</strong></td>
</tr>
<tr>
<td>Local GW</td>
<td>Check the <strong>Local GW</strong> box</td>
</tr>
<tr>
<td>RFC Destination</td>
<td><strong>NONE</strong></td>
</tr>
<tr>
<td>Software Version</td>
<td><strong>DEFAULT</strong></td>
</tr>
</tbody>
</table>

### 3.3 Configuring SAP Web Dispatcher

**Use**

SAP Fiori client applications are HTML5 applications that access multiple back-end systems. However, JavaScript code is constrained by the same-origin policy. For this reason, all systems are exposed to the browser through the SAP Web Dispatcher, which brings them into a common origin (combination of protocol, hostname, and port). In addition to solving the same origin problem, this enables you to control which services are effectively exposed to the client, reducing the system attack surface. You must implement and configure SAP Web Dispatcher as an SSL client in the system landscape.

We use a standalone SAP Web Dispatcher to deal with the incoming requests from the Front-End Server, (several) Back-End XSEs, (several) Back-End Enterprise Searches; below we’ll just have one ERP instance on HANA as an example.
Please notice that this chapter is optional if only Transactional apps are to be used. If you want to deploy Fact Sheets or Analytical Apps in your system landscape, you must perform the installation procedure. For more detail information regarding the installation of the SAP Web Dispatcher, please refer to Configuration Guide - Getting started with implementing the SAP Fiori Apps Rapid-Deployment Solution.

For more information regarding SAP Web Dispatcher, please refer to http://help.sap.com → Technology Platform → SAP NetWeaver → SAP NetWeaver 7.4 → Function Oriented View → Application Server → Application Server Infrastructure → Components of SAP NetWeaver Application Server → SAP Web Dispatcher.
Procedure

1. Access the operating system of SAP Web Dispatcher; edit its Instance Profile \textit{WDP}_{\textit{W}<\textit{Instance Number}>_<hostname>}.

   \begin{itemize}
   \item \textbf{Note}
   
   This is an example for Linux system. Since Web Dispatcher uses a different System Number from SAP NetWeaver, so if you install the SAP NetWeaver Gateway and the standalone SAP Web Dispatcher in the same server, the profile for SAP Web Dispatcher is not the one can be displayed in transaction RZ10.
   \end{itemize}

2. To enable HTTPS for Web Dispatcher, make sure that you have sapcrypto.dll file installed already. Add following profile parameters in the instance profile \textit{WDP}_{\textit{W}<\textit{Instance Number}>_<hostname>}.

   \begin{verbatim}
   DIR_INSTANCE = \textit{<SECUDIR.Directory>}
   ssl/ssl_lib = \textit{<Location_of_SAP_Cryptographic_Library>}
   ssl/server_pse = \textit{<Location_of_SSL_server_PSE>}
   ssl/client_pse = \textit{<Location_of_SSL_client_PSE>}
   wdisp/ssl_encrypt = 1
   wdisp/ssl_auth = 1
   wdisp/add_client_protocol_header = 1
   wdisp/ping_protocol = https
   icm/HTTPS/verify_client = 1
   \end{verbatim}

   \begin{itemize}
   \item \textbf{Note}
   
   The parameter \textit{wdisp/ssl_encrypt} determines whether the SAP Web Dispatcher encrypts the request again with SSL before forwarding it.
   \begin{itemize}
   \item \textit{wdisp/ssl_encrypt} = 0 (receives https encrypted data, web dispatcher decrypts the data and forwards unencrypted data to SAP Backend)
   \item \textit{wdisp/ssl_encrypt} = 1 (receives https encrypted data, web dispatcher decrypts the data, re-encrypt again and forwards encrypted data to SAP Backend)
   \item \textit{wdisp/ssl_encrypt} = 2 (the SSL is not terminated and request is sent encrypted to SAP Backend)
   \end{itemize}
   \end{itemize}

   \begin{itemize}
   \item \textbf{Example}
   
   The following example shows the profile parameter settings to enable HTTPS for Web Dispatcher.
   \begin{verbatim}
   wdisp/ssl_encrypt = 1
   wdisp/ssl_auth = 1
   wdisp/add_client_protocol_header = 1
   wdisp/ping_protocol = https
   icm/HTTPS/verify_client = 1
   DIR_INSTANCE = /.
   ssl/ssl_lib = /sapmnt/ABA/exe/uc/linuxx86_64/libsapcrypto.so
   ssl/server_pse = /usr/sap/WDP/W03/sec/SAPSSLs.pse
   ssl/client_pse = /usr/sap/WDP/W03/sec/SAPSSLc.pse
   \end{verbatim}
   \end{itemize}

3. Add following profile parameters for ICM ports:

   \begin{verbatim}
   icm/server_port_0 = PROT=HTTPS,PORT=<Web Dispatcher Port>,TIMEOUT=120
   \end{verbatim}
Example

icm/server_port_0 = PROT=HTTPS,PORT=1081,TIMEOUT=120

4. Add following profile parameters for Web Dispatcher routes:

   wdisp/system_0 = SID=<Front-End SID>, MSHOST=<Front-End Hostname>, MSPORT=<Front-End Messaging Port>, SRCSRV=*:<Web Dispatcher Port>, SRCURL=/sap/opu/;/sap/bc/;/sap/saml2;/ui2/nwbc/, CLIENT=<Front-End client>
   wdisp/system_2 = SID=<HANA SID>, EXTSRV=<HANA XS URL>, SRCSRV=*:<Web Dispatcher Port>, SRCURL=/sap/hba/;/sap/hana/;/sap/bi/;/sap/viz/;/sap/vi/;/sap/ui5/

Example

The following example shows the profile parameter settings for Web Dispatcher routes.

   wdisp/system_0 = SID=ABA, MSHOST=vhcalabaci.wdf.sap.corp, MSPORT=8101, SRCSRV=*:1081, SRCURL=/sap/opu/;/sap/bc/;/sap/public/bc/;/sap/saml2;/ui2/nwbc/,CLIENT=080
   wdisp/system_1 = SID=ERP, MSHOST=vhcalerpci.wdf.sap.corp, MSPORT=8101, SRCSRV=*:1081, SRCURL=/sap/es/, CLIENT=180
   wdisp/system_2 = SID=HDB, EXTSRV=https://vhcalhdbdb.wdf.sap.corp:4302, SRCSRV=*:1081, SRCURL=/sap/hba/;/sap/hana/

5. Save the Instance Profile and restart the Web Dispatcher process.

   Note

   To ensure confidentiality and integrity of data, we recommend encrypting communication path for web browser to SAP Web Dispatcher. To enable SAP Web Dispatcher to use https, refer to chapter Enable Web Dispatcher to Use HTTPS in Building Block Configuration Guide - Basic Network and Security Configuration
3.4 Setting up the Fiori Launchpad and Launchpad Designer

3.4.1 Automated Configuration with Task Lists

3.4.1.1 Task List SAP Fiori Launchpad Initial Setup

Use

You use task list SAP_FIORI_LAUNCHPAD_INIT_SETUP to activate Launchpad OData and HTTP services on an SAP Gateway system (frontend).

Procedure

1. Log on to your SAP ABAP system.
2. Call the following transaction:
   
<table>
<thead>
<tr>
<th><strong>Transaction Code</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>STC01</td>
</tr>
</tbody>
</table>

4. Choose Generate Task List Run (F8). The Maintain Task List Run screen is displayed.

1. Note

   Task 'Customize Launchpad URL for Cache Buster' is used to create an external alias for the default Launchpad URL for the use of cache buster. In case the external alias already exists, the step is skipped. The advantage of Cache Buster is that resources in the cache are only reloaded when a new version is available. Rather than simply limiting the time a resource may remain in the browser cache, the system invalidates the cache only when resources are actually updated on the server.

5. Choose to change parameters or keep it as default.
6. Choose **Start/Resume Task List Run in Dialog (or in Background)**. Once the task list run has been finished successfully, green lights appear in the **Status** column.

**Result**

You have successfully carried out the task list run **SAP_FIORI_LAUNCHPAD_INIT_SETUP**.

To check the task list run, call the respective transaction and check the successful activation:

- **/IWFND/MAINT_SERVICE**
  - `/UI2/INTEROP`
  - `/UI2/PAGE_BUILDER_PERS`
  - `/UI2/PAGE_BUILDER_CONF`
  - `/UI2/PAGE_BUILDER_CUST`
  - `/UI2/TRANSPORT`
- **SICF (Activate HTTP Services for SAP Fiori Launchpad)**
  - `/sap/bc/ui2/nwbc`
  - `/sap/bc/ui2/start_up`
  - `/sap/bc/ui5_ui5/sap/ar_svc_launch`
  - `/sap/bc/ui5_ui5/sap/ar_svc_news`
  - `/sap/bc/ui5_ui5/sap/ar_svc_upb_admn`
  - `/sap/bc/ui5_ui5/ui2/ushell`
  - `/sap/public/bc/ui2`
  - `/sap/public/bc/ui5_ui5`
- **SICF (Activate HTTP Services for UI5)**
  - `/sap/bc/ui5_ui5/ui2`
  - `/sap/public/bc/ui5_ui5`

### 3.4.2 Manual Activity (Optional)

**Note**

All these manual configuration steps has been covered by **Automated Configuration with Task Lists**. If all the task lists have been carried out successfully, all these steps mentioned in the chapter can be skipped.

### 3.4.2.1 Gateway System: Activating Launchpad OData Services

**Use**

In this activity, you activate the corresponding OData service for SAP Fiori Launchpad and Launchpad Designer.
Procedure

1. Login to the front-end server.
2. Access the activity using the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP Reference IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRO</td>
<td>SAP NetWeaver → Gateway → OData Channel → Administration → General Settings → Activate and Maintain Services</td>
</tr>
</tbody>
</table>

3. On the Activate and Maintain Services screen, choose Add Service.
4. On the Add Service screen, choose Local as the System Alias. A list of services is then displayed.
5. Choose the entry with technical service name /UI2/ LAUNCHPAD (Service for accessing Launchpad links).
6. In the Add Service dialog box, specify Package, choose ICF Node as Standard Mode, and then choose Continue (Enter). A message is displayed at the bottom of the screen informing you that Service '<Service Name>' successfully created. Choose Back (F3).
7. Perform steps 5 to 7 for following services respectively:

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/UI2/PAGE_BUILDER_CONF</td>
<td>Page Builder - Configuration Level</td>
</tr>
<tr>
<td>/UI2/PAGE_BUILDER_CUST</td>
<td>Page Builder - Customizing Level</td>
</tr>
<tr>
<td>/UI2/PAGE_BUILDER_PERS</td>
<td>Page Builder - Personalization Level</td>
</tr>
<tr>
<td>/UI2/INTEROP</td>
<td>Gateway Service of Interoperability</td>
</tr>
<tr>
<td>/UI2/TRANSPORT</td>
<td>UI2: Transport Service</td>
</tr>
</tbody>
</table>

8. In the Activate and maintain Services screen, call each service once by selecting it and clicking Call Browser in the screen area ICF Nodes. Always select the OData node, not the SDATA node.

    Note

    A service has been successfully called when an XML document is displayed without any error messages. Once a service is called, a hash key is generated in the background. The hash key is required for the generation of authorizations described in the chapter Configuring Authorization Roles.

Result

The mentioned OData services have successfully activated.

3.4.2.2 Gateway System: Configuring ICF Nodes

Use

In this activity, the corresponding ICF nodes for SAP Fiori Launchpad UI are activated.
Procedure

1. Login to the ABAP front-end server.
2. Access the activity using the following navigation options:
   
   | Transaction Code | SICF |

3. Choose **Execute**. The **Maintain Service** window displays.
4. Activate following relevant paths.
   
   /sap/bc/ui2/start_up
   /sap/bc/ui2/nwbc/
   /sap/bc/ui5_ui5/ui2/ushell
   /sap/bc/ui5_ui5/sap/arsvc_upb_admn
   /sap/bc/ui5_ui5/sap/ar_srvc_news
   /sap/bc/ui5_ui5/sap/ar_srvc_launch
   /sap/public/bc/ui5_ui5/
   /sap/public/bc/ui2/
   /sap/public/bc/icf/logoff

Result

The mentioned ICF nodes have successfully activated.

3.4.2.3 Gateway System: Activating the Cache Buster

Use

You can activate the cache buster for the SAP Fiori Launchpad and SAP Fiori apps by using an SICF service. The advantage of Cache Buster is that resources in the cache are only reloaded when a new version is available. Rather than simply limiting the time a resource may remain in the browser cache, the system invalidates the cache only when resources are actually updated on the server.

Procedure

1. In the SAP Gateway system, access the activity using one of the following navigation options:
   
   | Transaction Code | SICF |

2. On the Maintain Services screen, choose **Execute (F8)**.
3. Navigate to the following services and choose **Activate Service** in the context menu.
4. `default_host → sap → bc → ui2 → flp`. 
Results

After activating the SICF service, the Launchpad with cache buster can be accessed under any of the following URLs:

- https://<server>:<port>/sap/bc/ui2/flp

Note

The cache buster for the SAP Fiori Launchpad and SAP Fiori apps is not active by default. For more information, see Cache Buster for SAP Fiori

3.4.3 Gateway System: Configuring Login Screen for Launchpad and Launchpad Designer

Use

The logon page of the SAP Fiori Launchpad is configured in this activity.

![Login Screen](image)

Procedure

1. Login to the ABAP front-end server.
2. Access the activity using the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SICF</th>
</tr>
</thead>
</table>


4. Go to default_host→sap→bc→ui5_ui5→ui2


6. Choose the Error Pages Tab.

7. Choose System Logon and then choose the Configuration button beside.

8. On the System Logon Configuration dialog box, Choose Custom Implementation and input /UI2/CL_SRA_LOGIN into the ABAP Class text field.

9. Choose Save.

10. On the Create/Change a Service screen, choose Save.


Result

The default logon page is configured. Then you will see this logon page if you visit the Launchpad through http(s)://<FronEndServer>:<Port>/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html?sap-client=<Client>

3.4.4 Gateway System: Adapting the Logout Page in the SAP Fiori Launchpad (Optional)

Prerequisites

The Authorization Obj. S_ADMI_FCD is needed to edit Error Pages.

Use

Once the user is logging out from the SAP Fiori Launchpad via the Log Out button a Logoff page is displayed. This section describes how to redirect the html call to a different page. This example describes the redirection to SAP Fiori Launchpad again. Any other URL might be set here which, fits to the customer needs.

Procedure

1. Access the following transaction:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SICF</th>
</tr>
</thead>
</table>

2. Choose Execute (F8).

3. Expand the folder default_host → sap

4. Find the services navigating to this path:
5. Double-click the selected service.
6. Choose Change (Ctrl+F1).
7. Select tab Error Pages.

Note
If the customers are using SAML2.0 authentication method to login to the SAP Fiori Launchpad, there is an additional setting need to be modified. In the sub-tab Logon Errors, select the System Logon instead of Explicit Response Time.

8. Select sub-tab Logoff Page.
9. Choose option Redirect to URL. Enter the URL to be called after the logout in the field Redirect.

Note
For a redirection to the SAP Fiori Launchpad, enter the following link:
http(s)://<FrontEndServer>:<Port>/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html?sap-client=<Client>

For a redirection to the SAP Fiori Launchpad through the SAP Web Dispatcher, enter the following link:

10. Choose Save.
11. Select Display → Change (CTRL+F1) button.

**Transaction Code** | **SPRO**
---|---
**SAP Reference IMG Menu** | **SAP NetWeaver → Gateway → Odata Channel → Configuration → Connection Settings → SAP NetWeaver Gateway to SAP System → Manage RFC Destinations**

⚠️ Caution

If the customers are using X.509 authentication method to login to the SAP Fiori Launchpad, the logout function may not work properly. For more detail information regarding Fiori Logout page, please refer to SAP Note 1984739

**Result**

After logging off from the SAP Fiori Launchpad the html page maintained is being called.

### 3.4.5 Gateway System: Configuring Authorization Roles

**Use**

Users need authorization roles to run the SAP Fiori Launchpad (as an end user) and the SAP Fiori Launchpad designer (as an administrator). When users have these roles, they can access the catalogs and groups assigned to the roles by a role administrator.

**Procedure**

1. Login to the ABAP front-end server.
2. Access the activity using the following navigation options.

   **Transaction Code** | **PFCG**

3. In *Role Maintenance* (transaction PFCG), copy the roles *SAP_UI2_ADMIN_700* to your customer namespace.
4. Add additional authorization default entries in the copied roles for the TADIR Service. On the *Menu* tab, choose ➔ and select *Authorization Default*.
5. In the *Service* pop-up that opens, select *TADIR Service* and specify the following values:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Program ID</em></td>
<td>R3TR</td>
</tr>
<tr>
<td><em>Object Type</em></td>
<td>IWSG</td>
</tr>
<tr>
<td><em>TADIR Service</em></td>
<td>Use the value help to select the correct object name. Enter the names of the activated services (see Activating Launchpad OData Services).</td>
</tr>
</tbody>
</table>
1. The TADIR Service names in SAP NetWeaver Gateway are as follows

<table>
<thead>
<tr>
<th>Role</th>
<th>TADIR Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZSAP_UI2_ADMIN_700</td>
<td>ZINTEROP_0001</td>
</tr>
<tr>
<td></td>
<td>ZPAGE_BUILDER_PERS_0001</td>
</tr>
<tr>
<td></td>
<td>ZPAGE_BUILDER_CUST_0001</td>
</tr>
<tr>
<td></td>
<td>ZPAGE_BUILDER_CONF_0001</td>
</tr>
<tr>
<td></td>
<td>ZTRANSPORT_0001</td>
</tr>
</tbody>
</table>

6. Choose Copy.

7. On the Authorizations tab, click Propose Profile Name next to the Profile Name field.

8. Choose Change Authorization Data. On the screen that opens up, click the Generate button.

9. Save the settings.

10. Repeat the steps 3 to 8 for the role SAP_UI2_USER_700 as a template and assigning only a subset of services:

<table>
<thead>
<tr>
<th>Role</th>
<th>TADIR Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZSAP_UI2_USER_700</td>
<td>ZINTEROP_0001</td>
</tr>
<tr>
<td></td>
<td>ZPAGE_BUILDER_PERS_0001</td>
</tr>
</tbody>
</table>

© 2016 SAP SE or an SAP affiliate company. All rights reserved.
3.4.6 Gateway System: Assign Generic Roles for Administrators and End Users

**Use**

Different activities require different roles for authorization. Some are application-specific, some are app-type-specific, and some are more generic, e.g. used for general UI services.

**Procedure**

1. In the SAP Gateway system, access the activity using one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>PFCG</td>
<td>Tools → Administration → User Maintenance → Role Administration → Roles</td>
</tr>
</tbody>
</table>

2. On the Role Maintenance screen, enter the PFCG role for Business Catalog in the Role field: `ZS_AP_UI2_ADMIN_700`.

3. Choose Change.

4. On the Change Roles screen, choose the User tab page.

5. Insert the administrator user ID/name in the User Assignments area, for example, FIORIADM.

6. Repeat steps 2-5 to assign another role `ZS_AP_UI2_USER_700` to the test user ID/name, for example, FIORIUSER.

7. Choose Save (Ctrl+S).

3.4.7 Testing the Fiori Launchpad

**Use**

In this activity, you check whether the Fiori Launchpad can be displayed properly.

**Procedure**

1. Login to the Fiori Launchpad as the <End User> (for example, FIORI_USER).

   http(s)://<web dispatcher server>:<webdispatcher port>/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html

   **Note**

   If the SAP Web Dispatcher is not configured, then the following link can be used to login to the Fiori Launchpad:

   http(s)://<Frontend server>:<Frontend port>/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html
2. The search option ![search icon] should be visible in the shell bar on the Fiori Launchpad.

   ![Note]
   The Search option is the entry for Enterprise Search and to search the apps in the Fiori Launchpad Homepage

3. The Fiori Launchpad homepage should display without any issue.

### 3.5 Generic Configuring for Fact Sheet

#### 3.5.1 Backend System: Assign Roles for Embedded Search Administration

**Use**

Fact Sheets are shown in the result list of embedded search. Therefore embedded search need to be enabled. The required authorization to administrate embedded search is to be granted.

**Procedure**

1. In the backend ERP system, access the activity using one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>PFCG</td>
<td>Tools → Administration → User Maintenance → Role Administration → Roles</td>
</tr>
</tbody>
</table>

2. On the Role Maintenance screen, enter PFCG role `{SAP_ESH_LOCAL_ADMIN}` in the Role field.
3. Choose *Change*.
4. On the *Change Roles* screen, choose the *User* tab page.
5. Insert the user ID/name in the user assignment area, e.g. FIORI_ADM
6. Choose *Save (Ctrl +S)*.
3.5.2 Backend System: Activating Embedded Search Business Functions

Use

Fact Sheets are shown in the result list of embedded search. Therefore embedded search need to be enabled. In order to enable embedded search, certain business functions need to be activated first in the system. This is cross-client setting.

Procedure

1. Login to the backend ABAP server, for example: ERP system.
2. Access the activity using the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP Reference IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEWS</td>
<td>Activate Business Functions</td>
</tr>
</tbody>
</table>

4. Expand the node ENTERPRISE_BUSINESS_FUNCTIONS. A list of business functions is then displayed.
5. Choose the entry with name BSESH_HANA_SEARCH and BSCBN_HANA_NAV. Check if they're in active status (marked in yellow and the bulb is on).
6. If they are not active, select the check box Planned Status, Choose Activate Changes.

3.5.3 Automated Configuration with Task Lists

3.5.3.1 Task List Initial Setup of Embedded Search (Client 000)

Use

Use task list SAP_ESH_INITIAL_SETUP_000_CLIENT to finish the initial setup of Embedded Search in Client 000.

Procedure

1. Login into Backend ABAP Server, e.g. ERP system. Use Client 000.
2. Call the following transaction:

<table>
<thead>
<tr>
<th>Transaction Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>STC01</td>
</tr>
</tbody>
</table>

4. Choose **Generate Task List Run (F8)**. The Maintain Task List Run screen is displayed.

5. Before starting the task list run, make sure you have the Execute checkbox for the respective task list selected:
   - Confirm that all Preconditions are Fulfilled [Manual step ]
   - Collect System Settings [Parameter maintenance]
   - Start Update of Model Data with Client Information

6. As the icon in the Status column implies, the first task displayed in this list has to be carried out manually: **Confirm that all Preconditions are Fulfilled**

7. Once the manual task has been finished, choose the **Figure** icon in the Status column.

8. Confirm the popup message. A green light indicating Executed successfully is displayed in the Status column.

9. Choose the **Figure** icon in the Parameter column to change parameters.

10. Maintain the client information to specify the clients used for search.

11. Choose **Start/Resume Task List Run in Background**.

   **Note**

   Since it is a long running task, execute in background is always preferred.

**Result**

You have successfully carried out the task list run **SAP_ESH_INITIAL_SETUP_000_CLIENT**.

### 3.5.3.2 Task List Initial Setup of Embedded Search (Working Client)

**Use**

Use task list **SAP_ESH_INITIAL_SETUP_WRK_CLIENT** to finish the initial setup of Embedded Search in working client.

**Procedure**

1. Login into Backend ABAP Server, e.g. ERP system. Use working client.

2. Call the following transaction:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>STC01</th>
</tr>
</thead>
</table>

4. Choose **Generate Task List Run (F8)**. The Maintain Task List Run screen is displayed.

5. As the icon in the **Status** column implies, the first task displayed in this list has to be carried out manually: **Confirm that all Preconditions are Fulfilled**

6. Once the manual task has been finished, choose the icon in the **Status** column.

7. Confirm the popup message. A green light indicating Executed successfully is displayed in the **Status** column.

8. Choose the icon in the **Parameter** column to change parameters in Set TREX Destination or **SAP HANA DB Connection**.

   - **Note**
     
     The option **Use SAP HANA Primary DB Connection: DEFAULT** is preferred.

9. Choose the icon in the **Parameter** column to change parameters in Select **Models to Create Connectors**

10. Maintain the Software Component and its models to create connectors.

    - **Note**

    For Customer environment, connectors are required to be generated for all the models under **SAPAPPLH**.

11. Choose **Start/Resume Task List Run in Background**.

    - **Note**

    Since it is a long running task, execute in background is always preferred.

**Result**

You have successfully carried out the task list run SAP_ESH_INITIAL_SETUP_WRK_CLIENT.
3.5.4  Manual Activity (Optional)

Note

All these manual configuration steps has been covered by Automated Configuration with Task Lists. If all the task lists have been carried out successfully, all these steps mentioned in the chapter can be skipped.

3.5.4.1  Backend System: Prepare Model Data

Use

The updates of model data are firstly prepared in Client 000, then replicated to target client. To prepare the model data, certain program is to be executed in background.

Procedure

1. Login into Backend ABAP Server, e.g. ERP system. Use Client 000.
2. Access the transaction using the following navigation option:
   
<table>
<thead>
<tr>
<th>Transaction code</th>
<th>SE38</th>
</tr>
</thead>
</table>

3. Specify the program name `ESH_OM_PREPARE_MODEL_DATA`
4. From menu choose `Program -> Execute -> Background`
5. In the `Execute Report in Background` screen, choose `Execute immed`.
6. A system job `ESH_OM_PREPARE_MODEL_DATA` will be created and running for hours, wait and see the job log to make sure it finished in success.

3.5.4.2  Backend System: Check Primary Database Connection to SAP HANA

Use

Fiori search could use a newly created secondary DB connection to access SAP HANA, but that is normally used for side-car scenario. With the backend system already on SAP HANA, the primary DB connection is preferred. This is to check the name of primary DB connection.

Procedure

1. Login to the backend ABAP server, for example: ERP system.
2. Access the transaction using the following navigation option:
3. In the next screen as below, choose **System Configuration** in the left frame, the DB connection will be shown on the right frame, choose **Display**.

![DB Cockpit: System Configuration Maintenance](image)

4. The DB connection name can be found in the next screen as below:

![System Configuration Entry](image)

5. Note down the DB connection name for later usage.

### 3.5.4.3 Backend System: Creating a Connection Between Embedded Search and SAP HANA

#### Use

After the database connection is created, the embedded search needs to know where is the destination, which is the SAP HANA.

#### Procedure

1. Login into Backend ABAP Server, for example: ERP system.
2. Access the transaction using the following navigation option:

<table>
<thead>
<tr>
<th>IMG menu</th>
<th>SAP NetWeaver ➔ Search and Operational Analytics ➔ Common Settings for Operational Analytics and Embedded Search ➔ Configure Indexing ➔ Set TREX/BWA Destination or SAP HANA DB Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABAP Report</td>
<td>ESH_ADM_SET_TREX_DESTINATION</td>
</tr>
</tbody>
</table>
3. On the screen below, choose *Use SAP HANA*, and then specify the DB Connection Name as the one you noted down in previous step.

4. Execute the program, if successful a message will be shown in status bar.

## 3.5.4.4 Backend System: Activating Embedded Search UI Services

### Use

There are several central UI services used by embedded search, and they need to be activated in advance.

### Procedure

1. Login into Backend ABAP Server, for example: ERP system.
2. Access the transaction using the following navigation option:

<table>
<thead>
<tr>
<th>Transaction code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SICF</td>
</tr>
</tbody>
</table>

3. On the Maintain Services screen, choose Execute (F8).

Navigate to the following services and choose Activate Service in the context menu.

- `default_host → sap → bc → webdynpro → sap → ESH_ADMIN_UI_COMPONENT`
- `default_host → sap → bc → webdynpro → sap → esh_eng_modelling`
- `default_host → sap → bc → webdynpro → sap → esh_eng_wizard`
- `default_host → sap → bc → webdynpro → sap → esh_search_results_ui`
- `default_host → sap → bc → webdynpro → sap → wdhc_help_center`
- `default_host → sap → es → cockpit`
- `default_host → sap → es → saplink`
- `default_host → sap → es → search`
- `default_host → sap → es → ina`

## 3.5.4.5 Backend System: Create Search Connectors

### Use

Embedded search is based on active and consistent search connectors. In order to enable the search functionality, search connectors need to be created in advance.
Procedure

1. Access the activity using the following navigation option:

   Transaction Code | ESH_COCKPIT

2. Click Create, and then choose the software component you want to use, for example. SAPAPPLH, a list of available search connectors is shown below; those that were already created would be grey-out. Choose the search connectors you want to activate, for example. The ones you found in previous step, then choose Create Connector.

   ![Create Search Object Connector]

3. A background job will be triggered to create the search connectors. It might run for hours, depending on the number of search connectors. The job name is ESH_<your client>_C_<unique code>.
4. Wait till the job finished or terminated, if it is terminated, check the job log to see what the error message is and start trouble-shooting. If job finished in success, go to ESH_COCKPIT again and the newly created search connectors should have the following status: Status Active and Search is flagged.

3.5.4.6 Backend System: Schedule Indexing

Use

Some search connectors are created with Status Prepared instead of Active. For these search connectors, schedule indexing is required.

Procedure

1. Access the activity using the following navigation option:

   | Transaction Code | ESH_COCKPIT |

3. In the pop-up window, select Start Immediately, then choose OK.
4. A background job is triggered. Job name is ESH<your client>IX_<system id + client>_<unique code>.
5. If the job finished in success, the search connector status should change to Active.
3.5.5 Backend System: Check UI Area Key for Fact Sheet

Use

Sometimes the key entries in a system table are not present and cause search model error. Check this before creating search connectors.

Procedure

1. Login into Backend ABAP Server, for example: ERP system.

   Note
   This procedure needs to be performed in both client 000 and the client where the fact sheets are going to be used.

2. Access the transaction using the following navigation option:

   Transaction code SE16

3. Specify the table name: ESH_OM_UI_AREA, and open the table content.

4. Check if there are two entries with UI_AREA value set to FACTSHEET and LONGTEXT.

5. If such entries don’t exist, create them manually:

<table>
<thead>
<tr>
<th>GUID</th>
<th>UI_AREA</th>
</tr>
</thead>
<tbody>
<tr>
<td>5CF3FCDA894C1EE2A5A8C83A9376D459</td>
<td>FACTSHEET</td>
</tr>
<tr>
<td>00300583074102EF90EF80FEFE8A1385</td>
<td>LONGTEXT</td>
</tr>
</tbody>
</table>

3.6 Generic Configuration for Analytical App

   Note
   This section is only needed for Analytical Apps created by SAP Smart Business Modeler.

3.6.1 HANA DB: Assign Roles for Accessing SAP Smart Business Modeler

Procedure

1. Open the HANA Studio, on the Systems view, choose Security.
2. Locate the admin user (for example: Fiori_adm) and open user profile, on the Granted Roles tab, choose +.
3. Input `sap.hba.r.sb.core.roles::SAP_SMART_BUSINESS_MODELER`. Choose OK.
4. Repeat steps 2 and 3 to assign another role to both end user and admin user(Fiori_user or Fiori_adm): `sap.hba.r.sb.core.roles::SAP_SMART_BUSINESS_RUNTIME`.

5. Choose Save (Ctrl+S).

3.6.2 Gateway System: Assign Role for Accessing SAP Smart Business Modeler

Procedure

1. In the SAP Gateway system, access the activity using one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>IMG Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>PFCG</code></td>
<td><code>Tools → Administration → User Maintenance → Role Administration → Roles</code></td>
</tr>
</tbody>
</table>

2. On the Role Maintenance screen, enter the PFCG role for Business Catalog you noted down before in the Role field: `/UI2/SAP_KPIFRW5_TCR_S`.
3. Choose Change.
4. On the Change Roles screen, choose the User tab page.
5. Insert the admin user and end user (for example: Fiori_adm and Fiori_user) in the user assignment area.
6. Repeat steps 2-5 to assign another role to admin user(for example: Fiori_adm): `/UI2/SAP_KPIMOD_TCR_S`.
7. Choose Save (Ctrl+S).
3.6.3 HANA DB: Check Time Dimension

Use

In this activity, the date and time tables used by the content packages are filled with the data relevant for the system landscape. Check table `M_TIME_DIMENSION` in schema `_SYS_BI` to confirm the time generation is ready to use (the table is not empty). If the table is empty, proceed as follows:

Procedure

1. Log on to SAP HANA studio as a SYSTEM user.
2. Open perspective `SAP HANA Modeler`, open the menu, `Help → Quick Launch` to open Quick Launch page.
3. Choose the HANA System.
4. Choose `Generate Time Data`.

![Image of SAP HANA Modeler interface for generating time data]
5. In the Generate Time Data dialog, input following values and choose **Generate**:

   ![Generate Time Data dialog](image)

   **Note**
   
   The values provided here are just an example, modify these according to the customers' needs.

6. Check table `M_TIME_DIMENSION` in schema `_SYS_BI` to confirm the time generation is successful (the table is not empty).

   ![Table M_TIME_DIMENSION](image)
4 Transportation

Use

When implementing and configuring this rapid-deployment solution in a multi-tier customer landscape, the applied configuration settings need to be transported from one system landscape to the next (that is, from a development landscape to a quality landscape and to a productive landscape in case of a 3 tier landscape environment).

This section describes additional aspects which need to be taken into consideration while configuring SAP Fiori in a multi-tier landscape. As a prerequisite, the ABAP transport system between the systems needs to be configured properly.

Configuration settings that can be transported using the APAB transportation mechanisms and where no additional or subsequent steps are required are not mentioned in the following list.

Procedure

Find in the following table an overview on the steps where additional considerations are required.

<table>
<thead>
<tr>
<th>Chapter Name</th>
<th>Comment/Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway System: Assign role template for administrators</td>
<td>The user assignment needs to be carried through in each system. Find additional information on transporting pfcg Roles here: <a href="http://help.sap.com/saphelp_nw70ehp2/helpdata/en/6d/7c8cfd410ea040aaf92e1f78107a4/content.htm">http://help.sap.com/saphelp_nw70ehp2/helpdata/en/6d/7c8cfd410ea040aaf92e1f78107a4/content.htm</a></td>
</tr>
<tr>
<td>Task List SAP Gateway - Basic Configuration</td>
<td>No transportation available. This Task List needs to be executed in each tier landscape.</td>
</tr>
<tr>
<td>Task List Create Trusted Connection from SAP System to SAP Gateway</td>
<td>No transportation available. This Task List needs to be executed in each tier landscape.</td>
</tr>
<tr>
<td>Task List SAP Gateway - Add Backend System</td>
<td>The settings of this Task List are getting transported. Since the Task List contains the names of the underlying RFC connection - make sure that those connections are pointing to the appropriate system in your system landscape.</td>
</tr>
<tr>
<td>Task List SAP Basis SSL Check</td>
<td>This Task List is only for check purposes. It can be executed in each tier landscape.</td>
</tr>
<tr>
<td>Manual Activity (Optional)</td>
<td>In case you do not use the task lists you need to execute all steps in each tier landscape except the step for 'Gateway System: Creating System Alias'. Since the system alias contains the names of the underlying RFC connection - make sure that those connections are pointing to the appropriate system in your system landscape.</td>
</tr>
<tr>
<td>Chapter Name</td>
<td>Comment/Additional Information</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuring SAP Web Dispatcher</td>
<td>No transportation available. This Task List needs to be executed in each tier landscape.</td>
</tr>
<tr>
<td>Task List SAP Fiori Launchpad Initial Setup</td>
<td>Partial transportation available, not recommended for transportation.</td>
</tr>
<tr>
<td>Gateway System: Configuring ICF Nodes</td>
<td>No transportation available. This setting needs to be executed in each tier landscape.</td>
</tr>
<tr>
<td>Gateway System: Activating the Cache Buster</td>
<td>No transportation available. This setting to be executed in each tier landscape.</td>
</tr>
<tr>
<td>Gateway System: Configuring Authorization Roles</td>
<td>The user assignment needs to be carried through in each system.</td>
</tr>
<tr>
<td>Gateway System: Assign Generic Roles for administrators and end users</td>
<td>Find additional information on transporting pfcg Roles here: <a href="http://help.sap.com/saphelp_nw70ehp2/helpdata/en/6d/7c8cfd410ea040aadf92e1f78107a4/content.htm">http://help.sap.com/saphelp_nw70ehp2/helpdata/en/6d/7c8cfd410ea040aadf92e1f78107a4/content.htm</a></td>
</tr>
<tr>
<td>Backend System: Assign Roles for Embedded Search administration</td>
<td></td>
</tr>
<tr>
<td>Automated Configuration with Task Lists</td>
<td>No transportation available. This setting to be executed in each tier landscape.</td>
</tr>
<tr>
<td>Manual Activity (Optional)</td>
<td></td>
</tr>
<tr>
<td>Generic Configuration for Analytical App</td>
<td>No transportation available. The setting for all sub-chapters need to be executed in each tier landscape.</td>
</tr>
</tbody>
</table>
5 Appendix

5.1 Displaying Task List Documentation

All steps being executed via task lists can be checked beforehand.

Procedure

1. Log on to the ABAP system with the logon language English.
2. Call transaction STC01.
3. Enter the name of the task list.

Result

You get the complete documentation of the task list with a detailed task description.

5.2 Displaying Log Information for Task List Runs

Use

During execution of a task list, a log file is written in the background. In this step, you view detailed log information about a task list run.

Prerequisites

You have executed a task list or task list variant.

Procedure

1. Log on to your SAP ABAP system.
2. Call the following transaction:

   | Transaction Code | STC02 |

3. On the Task List Run Monitor screen, enter or search for the task list run you want to view in the Task List field.
4. Choose **Start Search** (F8). The **Task List Runs** screen is displayed.
5. Double-click the task list run you want to view.
6. On the **Display Task List Run** screen, choose ![Display Log](image).

**Result**

You have viewed information like:
- Task list run header information
- Task list information
- Task overview
- Task details

It is possible to download a ZIP file with the log information by choosing ![Download ZIP](image).